All journeys begin with a hunch or a desire to go somewhere. Our institution began its journey with the goal of improving medication administration processes. This recommendation was initiated from the work of both our Pharmacy and Therapeutics Committee and Patient Safety Committee. These multidisciplinary committees look at unusual occurrences and analyze them according to categories. After occurrences are categorized, there is an evaluation process to determine root causes of unusual occurrences. These committees also provide suggestions toward improving processes through system redesign, education, or individual counseling. There is an assumption that a voluntary reporting system, such as the one our institution has in place, captures only a small percentage of actual unusual occurrences. Another observation that played into the decision to improve medication administration processes is the increasing complexity of medications and patient acuity. Therefore, the recommendation to move toward a system that prevents medication errors at the point of administration became an institutional goal.

Before undertaking bar coding, the hospital investigated several options and new technologies, but efforts were not always well received. For example, physician order entry did not work out; at that time, the computer system was not easy for physicians to navigate. It was time consuming, and there were multiple fail points. There was poor buy-in from busy resident physicians. However, as a committee, Pharmacy and Therapeutics was committed not only to making medication administration methods as safe as possible for patients but also to reducing the number of errors that actually reach the patient. At the same time, the governing Board of Directors put forth the goal for hospital operations to improve patient safety. Multiple avenues converged and bar coding became an institutional goal. This decision was based on the increasing reports in the literature that bar code technology enhances the performance of medication administration. A clearly legible electronic medication administration record is part of the patient care record, and reports are available for warning/process improvement strategies. The success of this goal required commitment from top administrators, pharmacy, nursing, information management, and biomedical engineering. By the time the project was completed, the solicitation of cooperation and support extended even to loading dock personnel, who were responsible for delivery of equipment.
WHAT IS POINT-OF-ADMINISTRATION TECHNOLOGY?

Point-of-administration technology, or medication bar coding, is a technology that assists in ensuring the five rights to medication administration: (1) right patient, (2) right medication, (3) right dose, (4) right route, and (5) right frequency and time. The nurse is required to scan a name badge and enter a secure password on a stationary or mobile computer to gain access to the patient-specific medication administration record. The patient’s medication profile, which has been entered, checked, and approved through the pharmacy computer system, appears. The nurse scans the bar code on the medication. The application verifies the right drug, route, dose, frequency, and time; it also provides some decision support on contraindications by sending alerts.

IMPLEMENTATION BEGINS WITH PREPARATION

Real estate agents advise house hunters to focus on “location, location, location,” and in the computer industry, the saying goes, “garbage in, garbage out.” On our journey toward implementing this new application and work process, we began with “preparation, preparation, preparation.” This preimplementation work ensured a smooth go-live process, with minimal disturbance of patient care. Preparation for implementation and the prevention of “garbage in” were initiated by leadership who sought organization-wide support and active nurse involvement at all stages. Accomplishing organizational support took the form of oversight by a steering committee composed of representation from information management, pharmacy, nursing, and hospital administration (chief financial officer, chief nurse executive, and chief information officer).

The steering committee was actively involved in oversight and in smoothing out roadblocks for the project. One of the first tasks was system selection, and the committee defined the criteria to be met by any bar code vendor and sent a request for proposals out to vendors. Based on responses to the query, four vendors were invited to display their products on campus.

The next step to system selection involved bringing the vendors on-site and making sure to involve the persons who would do the bar coding (pharmacists, nurses, and respiratory therapists) for input and evaluation. Careful planning was required to make vendor visits and demonstrations convenient both in location and in timing for staff to attend, so that they could be actively involved in the evaluations of different systems. The location chosen was just off the employee cafeteria, which was easily accessible for the different shifts and different disciplines. As an incentive and expression of appreciation, light refreshment was offered as a bonus for participation in evaluation activities. Small tokens of incentive are critical; it sends a message that staff time and input are essential to the selection process. Whenever possible, implementation projects should budget for these expressions of appreciation for staff participation.

On-site demonstrations narrowed the field to two vendors. After making reference calls to query similar institutions about vendor performance, site visits were planned. Representatives from pharmacy, information management, and nursing attended. At the conclusion of this process, a multidisciplinary committee from information management, administration, nursing, and pharmacy reviewed the initial criteria from the proposal, along with information from the site visit, and made a final decision.

It must be noted that the selection process was time consuming and involved considerable planning, and it was not easy for staff to arrive at a consensus; however, when members of the selection task force left the table, everyone supported the decision, believing that it would improve patient safety.

After system selection and contract execution, preparations for embarking on bar coding began. Designing the workflow and the application to fit patients’ needs acted as a litmus test of the commitment of all parties to a workable process occurring within the specifications and limitations of the application.

PROCESS DESIGN: PROVIDING AN OVERALL SYSTEM FOR COMMUNICATION

The installation experts from the vendor and in-house clinical experts provided the direction for the design phase of the implementation. Other hospitals’ experiences also served as valuable benchmarks for ideas and suggestions for what might and might not work. However, probably one of the most valuable lessons during this phase of implementation was the realization that vendors cannot redesign their systems for a particular institution. During this part of the journey, the project is like climbing a mountain, and implementation can slow down or derail entirely, unless team members are committed to pulling part of the weight. Thus, the two mantra points focused on by design teams included “Plan-Do-Study-Act” and “communicate-communicate-communicate.” Even when we thought that enough information was provided, it was useful to communicate more. Even at times when the going was slow, we found that the time it took to understand and work through processes eventually resulted in progress.
Another difficult part of the design phase of the implementation was that time frames required prompt decision making and action. Although meeting deadlines required effort, time boundaries can be a blessing in disguise; projects involved in ceaseless planning can result in a cesspool of project immobility. In our organization, a phased implementation helped us keep to task and cope with the many unknowns. The application was designed for a housewide implementation with everyone at the table, but the implementation proceeded from one medical-surgical area to a critical care area and, step by step, throughout the institution. This helped propel the team forward. Also, immobility was avoided, and the entire project seemed more manageable when packaged in this manner.

**EASING THE BUMPS THROUGH SETTING UP PILOTS**

A journey into new territory often has bumps, surprises, and a few turns down side streets. To minimize these, we conducted a pilot implementation in two stages. Stage 1 consisted of bringing the application to a 23-bed children’s medical unit. This unit had experience with trying new things, had a stable staff, and had strong nursing leadership and a physician champion who assisted in paving the way. The second pilot was a 34-bed neonatal intensive care unit. This second pilot unit was planned to test the application’s handling of medication drips and complex medication regimes. The staff, pharmacy, nursing, and unit leadership on the neonatal intensive care unit were willing to devote resources to learning, teaching, and adapting the application to care for the complex neonatal patient. A clinical nurse specialist from the neonatal unit was instrumental not only in teaching staff but also in an advisory/problem-solving capacity.

**HARDWARE SELECTION, PLANNING, AND PROCUREMENT**

Planning the right tool for the job, selecting the right hardware, and procuring are of paramount importance before undertaking a journey into point-of-administration technology. A process of staff input, benchmarking with other institutions, and cost analysis was developed. One of the nagging questions that still haunts our institution is the quantity and storage of devices and accommodating the large number of pediatric patients who require isolation. A device for bar coding may be a mobile computer on a cart or a handheld device. Computers, mice, stands, and scanners were all part of the hardware planning. Our goal was to have an institutional standard, which can be tricky, especially since some departments preferred certain devices such as track ball mice, whereas others did not. No decision would fit all needs.

It is not uncommon for vendors to recommend a device per staff in a quantity that accommodates the largest number of staff on a shift. Our pilots provided some experience in this decision making and, as a guideline, our institution stuck with this standard. However, if resources and room size were not an issue, a device in every room and an adjunct handheld device for travel would most likely be the best of breed approach for bar coding. An objection to devices in every room might be that in the acute care setting, the bed space surroundings are owned by patients and should be respected by the nurse. People are sensitive to charting and placing information in the patient’s space. Also, many nurses like to chart in a seated position. However, the opportunities for patient-family teaching and the convenience of bedside charting might change some of these perceptions.

Some institutions run a vendor fair to assist with hardware selection. In retrospect, this probably would have been helpful to us. Our institution used the experience of other institutions successfully using bar coding as a benchmark, and our decisions relied heavily upon this. We also brought some samples of different hardware configurations for staff to view and try out. One of the truths about hardware, as with much of the computer industry, is that once a purchase is made, the existing technology has already evolved, and the purchase has become outdated. It is hoped that one day our existing computers on wheels will become outdated. The size of the computers on wheels is workable, and the carts do have what our institution has affectionately called a four-wheel drive; however, it can be a time-consuming challenge during off-shifts to navigate the hardware through semiprivate rooms quietly and efficiently. This is another reason to look at technology at every bedside whenever possible.

Hardware must be durable. It must be able to endure bumping, dropping, and the rigors of a clinical environment. A wise move is to solicit extensive nurse testing. Bring up a sample computer or handheld device. Do the scanners survive multiple drop tests? Is the setup rugged? Does the computer cart have a smooth turning radius? Does it fit between beds? Will the setup allow for easy cleaning between patients? There is no perfect hardware solution. The important part is to make an informed choice and take the time to solicit input and testing from the persons who will use the system before making a final decision.

Other aspects to keep in mind with hardware planning are delivery dates and in-house assembly, testing, and distribution of hardware. These are critical points that need nursing involvement. In our experience, it is best to allow plenty of time to order equipment; it is not unusual for companies to need 9 to 12 weeks’ lead time. Institutions must also have some idea
where to store equipment once it is on-site and assembled. Time is also needed for testing. We were still assembling the last remnants of our equipment the day of mock live for our pilot unit, which did not allow us to test each device thoroughly. It would have been best to allow the staff who would use the equipment time to deploy and test devices thoroughly prior to any mock live/go-live. Units need to plan resources for this leg of the journey. This important point centers on the fact that equipment needs to work on the spot, even for a pilot status. When equipment does not function up to expectations, even the slightest problem diminishes staff trust. It also decreases tolerance to roll with the punches of changing workflow.

**DESIGN TEAMS**

Design teams provide a method to obtain input for customizing an application to institutional needs. One size does not always fit all, and modifications must take place for a smoothly functioning process that works with the idiosyncrasies unique to an institution and the care required by its patient populations. Design teams plan for implementation from the point of patient admission through discharge. If there are potential pitfalls with organizations’ processes that may interfere with medication administration, this should be identified and handled before bar coding goes live. For example, in our institution, children were ID-banded with a certain type of band, and when the design team examined the process in detail, it was decided to change to a different brand to accommodate the bar coding system. The band solution is not a panacea, but the end result works. The ideal solution would take into account children’s different sizes, the ease of placing a band on a patient, and the patient’s comfort with the fit. We may achieve that in the future—or we may use biological identifiers. With our experience in implementing change, we are ready to keep on top of any new options and technologies that develop.

Design teams, by their nature, require a team approach. Our design team had pharmacy representatives, a nursing representative from each nursing unit, and a representative from information management. It was a light-hearted joke in our meetings that we needed a strong marriage to operationalize, and at times, marriage counseling was needed to keep our journey centered. The ideal that kept the design team on track was its overall focus on patient safety and a specific goal to improve medication administration. Key decisions included processes for allergies warnings, standardized hospital time frame for delivery of medications, warning decisions, cosignature requirements, and what was considered late and what was considered early. When possible, we implemented institutional changes (eg, the ID band change) prior to our pilot test to achieve incremental levels of change. Other points of decision included processes surrounding patients’ own medications, communications grids, and downtime procedures. Each of these topics probably involved at least two or three revisions, and it would behoove an institution to develop a process of evaluating whether the design team’s decisions should change after the system is up, stable, and running for a while, or to borrow an old saying, “until the bugs are out.”

**EDUCATION**

Education presents itself as commodity and opportunity. The super user approach is well established within the computer and healthcare realms. Having a well-trained core of experts in a practice area is an investment worth its weight in gold. The number and concentration of experts and a process that ensures comprehensive coverage of experts for all areas and all shifts are important issues for institutions to consider. Partnering with an institution’s leadership provides valuable assistance in ensuring adequate coverage. Materials for, and training of, super users provide a focal point of decision making. One way to approach the preparation of super users is a requirement that these experts be assigned to teach their peers the application and process. This helps reinforce the material and prepares these experts to assert their roles in a useful manner during the first days of go-live. The trick to this strategy is consistency of classes for the rest of the staff, which provides teaching experience for super users; many only have the opportunity to teach once or twice. Consistency may be assured by pairing a super user new to teaching with a veteran who assists and keeps the class on target. Another educational issue is reference materials for individuals. Practitioners in our institution seem to like one-page keypoint tips placed in strategic places. These one-page tips cover the basics, but the development and distribution of more extensive modules and packets of policies/procedures for detailed reference should occur as needed.

**GO-LIVE OR HOW TO SURVIVE TRAVEL FATIGUE**

Although we thought we had anticipated and planned for everything, during the staged approach, we learned to keep in mind the old adage: “be ready for the unexpected.” With successful implementations on the pilot unit and a critical care area, the organization was ready to apply the technology in four more acute care areas and one inpatient psychiatry area. We were ready to enjoy the scenery and were prepared to learn from our new territory.
However, surprises continued to occur; although both printing and connectivity were tested 1 week prior to go-live and the test went well, during the week of go-live, problems arose. The ability to take things in stride, a sense of humor, and problem-solving skills were important tools that made the journey easier for everyone involved. In retrospect, we learned that extra resources to assist practitioners and information management specialists are needed even in the final moments of a staged implementation. Always have an itinerary even if other areas have previously traveled the path.

Another unexpected issue arose in the first weeks of the implementation of the acute care units. Scanners started to malfunction because of bent USB ports. Patient rooms had little work space, especially at night when parents slept at the bedsides. After pulling the wireless cart into a patient’s room, nurses were tugging on the scanners to reach ID bracelets, and the force involved bent the USB port. Fortunately, we had ordered extra scanners, so damaged equipment was quickly replaced. Ultimately, plastic ties wrapping the scanner cord to the computer’s serial cable provided more stability, and since then, no scanners have been lost in this way.

These problems did not occur during previous stages of implementation in other units because patient rooms there had more space around beds. In the critical care unit, there was a computer within easy reach of all bed spaces.

Another side road that came up frequently during the journey were application navigation issues. An example of a problem encountered was an intermittent failure by some staff to remember some functions of the application; this resulted in an early warning that further action would result in “stealing a medication dose.” This was addressed in weekly Bar Code Updates, which included hardware tips, that were placed on each one of the bar code computers and at all the nurses’ stations.

Another method for mapping out side roads was our ongoing round table meetings and fine-tuning. Once the destination is achieved, it is wise to plan for continued process modifications, ongoing maintenance, problem solving, and fine-tuning of educational plans.

To address fine-tuning needs, regular meetings with nursing and pharmacy continue to tackle issues regarding the system. Staff representatives attending these meetings disseminate information to their respective units/areas. This committee reports to the hospital Nursing Practice Council and will continue to address practice issues and changes within the system.

The last leg of the journey is evaluation, and our institution evaluated the system through system-generated reports. This was important because report generation was a prime reason identified by our pharmacy and therapeutics committee for moving toward bar coding. Opportunities for learning abound from the system-generated reports; we are swimming in data. In the initial selection of a system, it is helpful to have an idea of what is possible, and as the system is designed, it is ideal to keep the destination of reporting in mind. The initial challenge to managing report-generated data is to identify the appropriate persons from different areas and disciplines to run the reports. Training on how to interpret and integrate reports into area/unit/discipline workflow should be designed into implementation. When the system is live, a focus on working on one aspect of medication administration is helpful; otherwise, it may seem overwhelming. In our case, some areas focus on cosignatures, other areas on their compliance with scanning, one on moving toward standardized times, and one on educating the nurses about how to affect the timing of medication.

We have learned many things on our journey. The most important lesson is that it takes a commitment of many to bring success to a major workflow change. Systems such as bar coding are part of larger culture changes that focus on improving patient safety through the incorporation of human factors as opposed to assigning blame.4-5 Creating safe processes empowers and requires collaborative efforts based on the expertise of multiple disciplines and participants. The net outcome is satisfaction in achieving the goal of improving patient safety at the point of care.

REFERENCES


Karen Carroll, PhD, RN, is Manager Nursing Informatics in Clinical and Organizational Development at Children’s Memorial Hospital in Chicago, Illinois.

Kathryn Owen, MSN, is the Nursing Informatics Specialist in Clinical and Organizational Development at Children’s Memorial Hospital in Chicago, Illinois.
Implementing an electronic medical record (EMR) is a significant project involving a large expenditure of staff time and resources. Healthcare facilities cannot afford to experience lack of acceptance and delayed implementation due to misconceptions or other barriers—real or perceived. One of the most vital components of implementation is the “preimplementation” phase of the project. Not recognizing issues prior to implementation may cause the technology to be blamed for documentation or workflow problems that are actually operational or process issues.

This article discusses the benefits as well as the steps used at Kindred Healthcare in a preimplementation phase. Kindred Healthcare is a long-term acute care healthcare organization that operates 80 hospitals nationally, 60 of which currently use a proprietary EMR in the inpatient setting.

At Kindred Healthcare, the preimplementation phase occurs approximately 4 weeks prior to the 8- to 10-week implementation of the EMR. Vendors or other organizations may use another name for this phase and its timing may vary. This phase includes not only the wiring and installation of hardware, but a facility visit by the team responsible for the implementation. At this visit, a workflow assessment and an executive briefing are performed. It is crucial that facility leadership be involved in all matters related to the implementation, including working through the impact the changes will have on physicians and other facility external customers. The decision to proceed with implementation is based on milestones being met during preimplementation.

COMPONENTS OF AN EFFECTIVE FACILITY VISIT

A preimplementation facility visit permits the implementation team to provide and obtain valuable information prior to the EMR implementation. It allows staff at the facility to reflect on their current documentation habits, their tolerance for change, and facilitates managing staff expectations. The visit also provides an opportunity for the users to obtain a clear understanding of what the system can and cannot do.

A detailed examination of current information processes is performed. Although a good EMR will not dictate treatment or rigid workflow processes, neither will it exactly mimic the existing operations. Because departments differ, the implementation process will vary from department to department and needs to be tailored to fit each situation. There will be a shift in workflow, but if these changes are implemented in an incremental fashion in the weeks prior to the EMR implementation, clinical buy-in of the EMR is enhanced. For example, in nursing we ask staff to standardize med times and change measurement of I&O times to a time prior to midnight.

QUESTIONNAIRES

To assist the preimplementation visit, a questionnaire soliciting information about the current workflow is developed for each department in the facility. These are distributed to all staff on all shifts by the appropriate department manager. Table 1 is an example questionnaire for the nursing department. The implementation project manager analyzes the results and uses this information to plan the facility visit and implementation. Common themes and how we use the information in the implementation process include the following:

- What are the “essential processes” for your department? In nursing this would include such things as assessments, medication administration, and wound care. This information is used to customize the training plan and implementation to meet the essential processes of the department.
Explain your current interdepartmental communication process. This information helps the implementation team manage staff expectations about what the EMR will and will not do. Staff often assume that all manual communication processes will end when the EMR is implemented. It also helps in making decisions about processes such as how verbal orders will be handled.

Are there any current staff in the department that have used an EMR in another organization? This information also helps in managing staff expectations and misconceptions. It may help to identify an ally in encouraging others about the benefits of the EMR, or someone who might be negative about EMRs.

What areas of documentation does staff currently struggle with to meet compliance? This information is important for the department leadership, and is labeled as an area of “risk.” It assists in the development of training and provides guidance for areas that need special attention.

What are the staff most encouraged about regarding the EMR implementation? The training team uses this information to allow them to focus on the strengths and positive attitudes of the department staff. Additionally, it gives some insight into possible unrealistic expectations about what the EMR will do.

What are the concerns of the staff regarding the EMR implementation? This allows the team to identify and discuss possible areas of difficulty.

What are some quick wins that will help the staff adopt the EMR? These might include automatic adding of I&Os and prompt PRN medication follow-up.

The overall goal is to be sure that implementation includes attention to psychosocial aspects as well as other concerns to improve the chance for a successful implementation.

THE FACILITY VISIT

This visit is considered the project kick off. The implementation project manager meets one on one with each department manager. The data obtained from the questionnaire are discussed in detail. Together, the department manager and the implementation project manager design a preimplementation action plan. This action plan includes topics and risks that need to be managed to facilitate the effective implementation of the EMR. A sample action plan can be seen in Table 2.

CONCLUSION

The preimplementation phase can have a positive impact on the implementation of an EMR. Even small facilities find the change to an EMR potentially overwhelming. By working with each department and the facility leadership to identify areas of risk before the change, the preimplementation team can help the facility implement processes...
to mitigate risk and be more prepared to handle the transition to technology. Addressing misconceptions head-on can be beneficial for the organization and facilitates a successful EMR implementation.

An important task in this period is to help all staff understand the difference between EMR problems and workflow/process problems. Understanding this difference provides information in determining whether the EMR implementation is a success or failure. It is easy to blame technology for workflow or other purely operational issues such as documentation. These organizational issues can easily derail an implementation. Providing an opportunity for the implementation team and the facility to become acquainted prior to the implementation also allows each group to gain a better understanding of the roles of each and the necessity for some changes.

One of the conflicts that face both preimplementation and implementation teams is that due to psychosocial issues they cannot always implement the best EMR practices. The team needs to understand the level of change that an organization can support and make decisions accordingly. Unfortunately, some facilities decide to stick to “known” practices rather than implement all the features of an EMR. Still, it is important for each facility to recognize the successes in what does get implemented and the impact they will have on patient safety, quality of care for patients, and quality of work life for staff. If the atmosphere created by the EMR is positive, needed improvements can be added later.

Ronelle Brumleve, BSN, RN, BC, works as a Clinical Informatics Coordinator for the Hospital division of Kindred Healthcare involved in training, implementation, and coordination of the clinical information systems. Kindred Healthcare hospitals provide acute care for ventilator-dependent and complex, medically compromised adult and child patients.

### Table 2: Sample Action Plan

**Hospital X preimplementation action plan**

**Overall Facility/CIS Steering Committee:**

- Identify “theme” for implementation (eg, patient safety, workflow improvements)
- Identify project governance. Who is the executive sponsor? Who is the nursing sponsor? Who is the physician sponsor?
- Develop communication plan for EMR.
- Identify core group of clinicians who will serve as the facility project team.
- Conduct project kick off with project team and validate communication plan. Confirm roles, responsibilities, deliverables, and timelines.
- Show mobile computers to staff via photographs.
- Identify and discuss current awareness of weaknesses and redundancy in paper documentation. (Identifying these prior to implementation allows quick wins to be identified.)
- Discuss, define, and document “ground rules” for use of EMR.
- Discuss with all staff what information will remain on paper versus EMR.
- Identify and resolve any current interdepartmental communication issues. (The EMR cannot be expected to solve underlying problems.)
- Communicate to staff to expect “process opportunities” (opportunities to improve processes) to arise during implementation.
- Develop education plan for new hire EMR training and continued training. Discuss and define how use of EMR will be incorporated in staff annual review and competencies.
- Obtain e-mail access for all super users on TEAM.

**Nursing:**

- Implement education plan for EMR based on the topics identified in workflow assessment (eg, care plan documentation, education plan documentation)
- Show and discuss changes related to shift report using computer-generated report tools.
- Educate staff about standard medication times. Consider having pharmacy director develop tools to handle issues such as one-time doses and late medications.
- Develop housewide policy on when I&O is calculated. Include this in clinician training.
- Define terms used for changes in patient parameters to assure valid entries in EMR.
- Identify whether restraint use will be documented on paper or the computer.
- Plan with nurse staffing agencies for training their staff on the EMR.
- Discuss with unit secretary how functions will change with EMR. Stress that their role is still vital to the organization of the unit. They are still vital in the scheduling and communication of patients’ information to all departments.
Using Formulas for Data Analysis in Excel: Creating a Grade Point Average Calculator

Jeanne P. Sewell, MSN, RN

Key Points:
• Calculations: Current date and Time; Logical functions, Totals, Averages
• Conditional formatting
• Protecting formulas

Nurse educators, administrators, and project managers are often required to analyze numerical data in an expeditious manner. For educators, frequent tasks include calculating grades and grade point averages (GPAs) and creating simple budgets for departments or grants. All of these can be automated and simplified with a technological solution. Microsoft Excel (Microsoft, Redmond, WA), an electronic spreadsheet software, is an easy-to-learn tool for organizing, displaying, and analyzing numbers. Excel can also perform the multiple calculations we frequently need in the workplace.

The purpose of this article is to demonstrate how Excel can be used to perform calculations, to format data according to rules, and to change a “letter” to a “number” automatically. The following example shows how to create a spreadsheet that calculates student GPAs. The GPA calculator can be used by faculty and students online, or stored on a disk and then saved as a template for future use.

CONVENTIONS USED IN INSTRUCTIONS

The screenshots and instructions are given for the Windows operating system (OS) but should be generalizable for the Apple Mac OS. The following conventions are used to simplify instructions:

1. An instruction with words separated by the greater than sign (>) denotes a menu which, when selected, provides another menu. Follow the directions by clicking on the selection from the menu.
2. The term “cursor” indicates the blinking insertion point in a text line.
3. The terms “click on” and/or “select” indicate moving the mouse pointer and clicking the left mouse button.

4. Using the control key in conjunction with another key is a keyboard shortcut. When you see an instruction Ctrl+Z, hold down the Ctrl (control) key while tapping the key that follows the plus (+) sign, then release both keys.

5. Items that you should select will be in boldface.

6. Items that you need to type will be in italics.

7. Drop-down menus are menu boxes with a solid triangle pointing down. Click on the triangle to make a selection from the menu.

CREATING, EDITING, AND USING EXCEL FOR DATA ANALYSIS

An Excel spreadsheet is a table consisting of a grid of rectangles (cells) in the form of columns and rows. Each cell can be uniquely formatted to display text data, numbers, or formulas. The number-crunching power of formulas makes Excel an invaluable tool for nurses. For example, think about calculating GPAs of applicants for an incoming class of nursing students. Many nursing programs have a pool of several hundred applicants for each class and GPA calculation is at least one component of the admission criteria used in the selection process. Some nursing programs have found that GPA of the science courses is a good predictor of success in nursing.

At Georgia College and State University, the GPA calculator is used by the nursing admissions committee for program admission decisions. The university uses the four-point scale with letter grades of A, B, C, D, and F. The nursing advisors distribute the GPA calculator to prenursing students so that the students can keep up with their own GPAs. Prenursing students use the calculator for what-if scenarios such as, “what if I make a B instead of a C in microbiology.” The custom Excel template, which includes all of the Georgia College and State University prenursing and nursing course information, is available for download online to both students and faculty (http://hercules.gcsu.edu/jsowell/nursing/GPA.XLT).

Many colleges and universities provide online GPA calculator solutions. Use the Google Internet search tool with the search terms “GPA calculator” or “GPA calculator xls” to find solutions. Examples include University of California Berkeley (http://www.aad.berkeley.edu/gpacalc.html), Iowa State University Office of the Registrar (http://www.iastate.edu/~registrar/gpa-calc/gpaCalculator.html), and University of Toronto Academic Advising and Career Center (http://www.utsc.utoronto.ca/~GPA_calculator/index.cgi). Although online GPA calculators are helpful, a nursing program custom solution has an advantage: program-specific course names and credit hours are already entered. When the file is saved as a Microsoft Excel template file (.xlt), the spreadsheet can be reused.

Copyright © Lippincott Williams & Wilkins. Unauthorized reproduction of this article is prohibited.
saved, and printed for individual students. It takes about 30 minutes to create a customized solution.

In this example, we will create a GPA calculator that calculates the average GPA for five prenursing science courses: Chemistry I and II, Anatomy and Physiology I and II, and Microbiology. If the student has received a D or lower in a science course, the cell with the grade will be displayed in a light orange color to alert the user of a below-average grade. When the science course grades are entered in the grade column, the earned credits, quality points, and the average GPA will be automatically calculated. After completion, the GPA calculator can be printed so that it can be filed with the prospective students’ application. Launch (open) Excel and then follow the directions below (Figure 1).

Create a New Worksheet

When you open Excel, the default file is a workbook that consists of three spreadsheets. We will be working only with the first spreadsheet in the workbook. Double-click on the “Sheet 1” tab at the bottom of the worksheet and rename it GPA Calculator to make it easy to identify. Next, save the file and name it GPA Calculator. As you type in data into the cells, you may see a string of ###### instead of what you typed if the column width is narrower than the data you typed. If you would like to adjust the width of the columns, it is simple to do—just place your cursor between the column letters until it turns into a crosshair and either double-click to auto-adjust the width or use the mouse to click and drag to adjust the column width. Remember to save your work frequently.

Entering Information Into the Worksheet With Current Date and Time

Now you are ready to enter data. Remember that columns run from top to bottom vertically and are labeled using the alphabet. The rows or records run from left to right horizontally and are numbered. The GPA calculator will have a title and include the date and time that it is completed. The date and time will be automatically generated from a formula when the worksheet is updated.

1. To title the form, click on cell B1. Type Nursing Science GPA Calculator.
2. To show when the file was updated, click on cell E1. Type Updated.
3. To show the current date, click on cell F1. Type =NOW(). Remember to place the equal sign (=) in the formula and resize the column to get rid of the ####.
4. To have the cell formatted for a date, right-click on cell F1. On the pop-up menu, click on Format Cells > Number > Date.
5. Select a date format that shows both the date and the time.

The formula in cell F1, =Now(), automatically shows the current date and time in order to identify the most current form, if the GPA had to be calculated more than one time. This formula will cause cell F1 to always show today’s date if the worksheet was calculated; it is not updated continuously. The NOW function is especially helpful if you keep a printed version of your files. Of course, you may prefer to enter the date manually.

Now we are ready to identify six column names for the GPA calculator: Class (the course classification), Course (the course number and name), Credit (credit hours), Grade (the grade the student made in the course), Earned Credits (the credit hours earned), and Quality Points (the quality points earned). Before you begin, make the columns wider so that you can see the data that you type into the cells.

1. Click on cell A2. Type Class.
2. Use the Tab key or point and click the mouse to move to cell B2. Type Course.
3. Repeat Step 2 to enter the remaining column headings: Credit, Grade, Earned Credits, Quality Points. Resize the columns so that you can view the column headings.

FIGURE 1. Example of a GPA Calculator Worksheet.
4. The next step is to enter all of the course information. Enter the Class, Course, and Credit data using Figure 1 as a guide.
5. In cell B10, type Total Credits/QP. In cell B11, type Science GPA. Highlight cells B10 and B11, and then tap the Right Align icon in the menu bar. When you finish, resize the columns so that you can view all of the data.

You are ready to enter the formulas that calculate credit hours, quality points, and the GPA.

Creating Calculated Fields

The GPA is the sum of quality points divided by the number of earned credits. We need formulas to calculate the quality points and earned credits for each course listed on the GPA calculator. Afterward, we will create a formula to sum the total earned credit hours and quality points. Finally, we will create a formula to calculate the GPA. To make things easier, we will create the formulas just once, then copy and paste them into the associated cells.

The earned credits and quality points are calculated using the logical function, IF, a very powerful formula. The IF formula is a conditional formula that returns one value if the condition you specify is TRUE, and another value if the condition is FALSE. You can include (nest) up to seven IF statement in a formula. If you make a mistake, do not panic. Use Undo (Edit > Undo Format Cells) to restore the changes.

Step A: Formula for Earned Credit Hours

The formula in Column E for earned credit hours looks at the Grade and returns a numerical equivalent for the grade. In cell E3, type the formula to determine the earned credit hours.

Type =IF(D3=“A,”4*E3,IF(D3=“B,”3*E3,IF(D3=“C,”2*E3,IF(D3=“D,”1*E3,IF(D3=“F,”“0,”“”)))))) to highlight the formula. If you made a mistake, do not panic. Use Undo (Edit > Undo Format Cells) to restore the changes.

- If the value in cell D3 is an “A” (the condition is TRUE), then multiply the value in E3 (Earned Credits) times 4 (the quality points for an “A”).
- If D3 is a “B,” then multiply the value in E3 (Earned Credits) times 3 (Quality Points for a “B”).
- If D3 is a “C,” then multiply the value in E3 (Earned Credits) times 2 (Quality Points for a “C”) and so on.
- If D3 is a “D,” then multiply the value in E3 (Earned Credits) times 1 (Quality Points for a “D”).
- If D3 is an “F,” then the quality points for an “F” are 0.
- If D3 is not equal to “A,” “B,” “C,” “D,” or “F” (the condition is FALSE), leave cell F3 blank.

Test the formulas to make sure that they work correctly. Type in the letter grade A in cell D3. You should see the number “3” in the E3 and the number “12” in F3. Test the formulas with the other letter grades, B, C, D, and F. Type in something other than the letter grades and nothing should happen.

Now that we have created the formulas that calculate earned credit hours and quality points, we need to copy the formulas into cells for each of the courses.

1. Click on cell E3 and drag the mouse to F3 to highlight the cells.
2. Right-click the mouse and select Copy.
3. Highlight the cells E4 through F9. Right-click the mouse and select Paste.

Step B: Formula to Calculate Quality Points

The next step is to type the formula to calculate the number of quality points. The Quality Points formula uses data for Grade and Earned Credits. The formula for Quality Points in Column F looks at the Grade in Column D and multiplies the associated Credit Hours in Column E times the equivalent Quality Points. In the example, we use the four-point scale where an “A” is four points, a “B” is three points, a “C” is two points, a “D” is one point, and an “F” is zero. Click in cell F3. Type =IF(D3=“A,”“0,”“4*E3,IF(D3=“B,”“3*E3,IF(D3= “C,”“2*E3,IF(D3=“D,”“1*E3,IF(D3=“F,”“0,”“”)))))) and tap the Enter key.

What the Quality Points formula in F3 means is this:

- If D3 is an “A” (the condition is TRUE), then multiply the value in E3 (Earned Credits) times 4 (the quality points for an “A”).
- If D3 is a “B,” then multiply the value in E3 (Earned Credits) times 3 (Quality Points for a “B”).
- If D3 is a “C,” then multiply the value in E3 (Earned Credits) times 2 (Quality Points for a “C”) and so on.
- If D3 is a “D,” then multiply the value in E3 (Earned Credits) times 1 (Quality Points for a “D”).
- If D3 is an “F,” then the quality points for an “F” are 0.
- If D3 is not equal to “A,” “B,” “C,” “D,” or “F” (the condition is FALSE), leave cell F3 blank.

Now that we have created the formulas that calculate earned credit hours and quality points, we need to copy the formulas into cells for each of the courses.

1. Click on cell E3 and drag the mouse to F3 to highlight the cells.
2. Right-click the mouse and select Copy.
3. Highlight the cells E4 through F9. Right-click the mouse and select Paste.

Step C: Formulas to Sum Credit Hours and Quality Points

The next step is to create formulas to sum the credit hours and quality points. After we create the final two formulas, we will be ready to test the GPA calculator again.

1. Click on cell E10, and then click on the AutoSum icon in the menu bar.
2. Click in Cell E3 and drag the mouse to highlight Cells E3 through E9. The formula (=SUM(E3:E9)) to sum their values is visible in the Formula Bar.
3. Tap the Enter key to accept the formula.
4. Right-click on E10 and select Copy and then click on F10. Right-click and paste the formula into the cell.
5. Test the formulas once again using all of the grades.

**Step D: Formulas to Calculate the Science GPA**

The last formula we create will be to calculate the Science GPA by dividing the sum of quality points in cell F10 by the sum of earned credits in cell E10. We will use another IF statement to prevent the error message “#DIV/0!” from showing up when the quality points in F10 is a “0” because no grades (or the GPA is a 0) have been entered into the GPA calculator.

1. Click on cell F11. Type =IF(F10=0, “0,” F10/E10).
2. Tap the Enter key to accept the formula.
3. Test the GPA calculator by entering grades once again. Remember to save your file frequently.

**Using Conditional Formatting**

As noted earlier, if the student has made a D or an F in a science course, the cell with the grade should be displayed in a light orange color as a flag. The conditional formatting feature allows you to specify a cell shading or font color for a given condition. You can specify up to three conditions. The condition is not case sensitive; you could type a “D” or “d” and the conditional formatting will still work.

1. Click on all of the cells from D3 through D9. Using the menu bar, select Format > Conditional Formatting.
2. For Condition 1, select Cell Value Is from the first drop-down menu, and then select equal to from the second drop-down menu. In the last box, type “d.”

If the cell value for the Grade is equal to either a “D” or “F,” the cell will turn a light orange color (see the diagram on Conditional Formatting). The conditional formatting has been applied to all cells in which you will enter a course grade. You will not see any change in the color of the cells until you enter a grade of “D” or “F.” Next, test the GPA calculator again.

**Control and Protect Formulas**

Finally, “protect” the formulas you created to prevent the user from accidentally corrupting them or deleting them. Excel offers the ability to protect part or all of a workbook, both with and without a password. IMPORTANT: All of the worksheet cells are “locked” by default, but only if the worksheet is protected. We need to specify the cells that we want the user to be able to modify, “unlock” those cells, and then protect the worksheet to prevent data entry in cells where there are formulas. We do not need to use a password to protect the data. Click in cell D3. Highlight D3 through D9.

1. Right-click > Format Cells > Protection > uncheck the Locked check box (remember that the cells are locked by default).
2. Click anywhere on the spreadsheet to clear the selection, and then click on the menu bar and select Tools > Protection > Protect Sheet.
3. Remove the check by “Select locked cells” and then click the “OK” button.
By placing a checkmark by the “Select unlocked cells,” the user will have access only to the unlocked cells.

**TEST THE CALCULATOR**

It is extremely important to test each condition specified in a formula before you disseminate the new form for others to use. The easiest way is to first enter course grades of all As, and the GPA should be 4.0; enter all Bs, and the GPA should be 3.0; enter all Cs, and the GPA should be 2.0; finally, enter all Fs, and the GPA should be 0. Make sure that the GPA calculates correctly. When you enter a D or an F, the cell shading should change to the light orange color. If you note any errors, unprotect the worksheet, make the necessary corrections, and then protect the worksheet again.

An example of the finished GPA calculator is shown in Figure 3. As noted earlier, the grades are not case sensitive; you can use either upper or lower case for the grades. The conditional formatting provides a visual alert about low course grades.

Once you are satisfied that the GPA calculator is working correctly, remove all of the grades you used for testing purposes in Column D.

**SAVE THE WORKSHEET AS A TEMPLATE FILE**

The GPA calculator is now functional. Go ahead and save the file as a template file. The template file is a master file that is stored with all of the other MS Office templates. This template can be used repeatedly and will provide you a fresh start to a new grade calculator sheet. It can also refresh your memory for the formulas you will need.

1. Click on File in the Menu bar > Save As.
2. Name the file GPA Calculator and then click the down arrow by the Save as type drop-down menu. Select Template (* .xlt).
3. MS Office will automatically default to saving the file in the Templates folder. Click the “OK” button.

The next time that you select File > New in Excel, you should see the GPA Calculator template. When you save a template file, Excel will save it as a worksheet file (.xls) by default. You can download the GPA calculator used for this example from http://hercules.gcsu.edu/jsewell/CIN/.

**CONCLUSION**

Excel can be used for many purposes because every cell can be uniquely formatted with text, numbers, and formulas. In this example, we used Excel to create a GPA Calculator using cells formatted with formulas. The NOW date formula was used to time and date the spreadsheet when it was opened. The IF formulas were used to calculate earned credit hours and quality points for a given letter grade. Finally, the AutoSum and division formulas were used to determine a GPA. The conditional formatting feature provided us with a visual flag for certain data entries. The Protect Worksheet prevented inadvertent formula corruption.

The formulas in this example can be used for a variety of purposes, such as budget analysis and patient outcomes analysis. With a little planning and some practice, you should be quickly on your way to creating tools that will assist you in analyzing data. We have covered only a few of the many formula features in this example, but this should provide a starting point for you as you further develop your Excel software skills.

**REFERENCES**


Jeanne P. Sewell, MSN, RN, is Assistant Professor of Nursing in the School of Health Sciences, Georgia College & State University, Milledgeville, GA 31061-0490.